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http://www.lib.odu.edu/libassist/howto/endnote/index.htm

EndNote is a powerful tool for organizing and managing citations that you acquire in various ways:

o Enter the citation manually

o Search a library catalog directly through EndNote

o Search a library database and export citations directly into EndNote

o Search a library database and import citations into EndNote with filters
You may then organize your references, images and PDFs and create bibliographies and figure lists. “Cite While
You Write” is a feature that allows you to incorporate references from your EndNote library directly into a
Word document as in-text citations and as footnotes or references.

How to Get the Endnote Program

ODU has a site license for EndNote. Faculty, staff and students can download EndNote from the OCCS
page on the University’s Web Site. Go to Computing / Hardware & Software / Downloads / For
Students, Faculty/Staff. You'll need to enter your MIDAS account.

> BASICS

Open EndNote: Start / Programs / EndNote / EndNote Program
Unless you want to use EndNote Web, choose “Do not integrate with EndNote Web at this time” — “Finish.”

Create an EndNote library:
1. Select “Create a new library” -- OK. Or, select “Open an existing library.”
(You may need to go to “File” / “New” to create a new library.)
2. Name the file and location for your library. It will have the extension: .enl
3. Click “Save” and your EndNote Library will open. The “library” is where your citations will be stored.

Enter a citation manually:
1. Click “References” in the top toolbar, and select “New Reference.”
2. Select a “Reference Type” (e.g., Journal Article) from the Reference Type dropdown menu at top, and
then enter the citation information in the appropriate fields.
3. When finished entering information, click “File / Close Reference” from the top toolbar, or click the
lower X at the top right.

Select a format style and view the reference:
1. Atthe top toolbar, choose an output style from the dropdown menu. The default is “Annotated.”
Choose “Select Another Style...” and select from the options (e.g., MLA, APA, etc). Click “Choose.”
2. Once you select a style, your references will appear in that style. Highlight a reference to view it in the
bottom Preview section.

Saving your references:
Your references are automatically saved in your .enl file. An associated .Data directory is also saved.

Page 1 of 6 -- 3/28/2009



To simply copy references from your library into a bibliography:
1. Select the appropriate style output.
2. Highlight the references you wish to use in your bibliography.
3. Right-click and select “Copy formatted” —then paste them into a Word document.
To format your paper with footnotes and bibliography, try “Cite While You Write.”

To create a copy of your library:

1. With alibrary open, choose Save a Copy from the File menu.

2. Name the new library and choose where to save it.

3. Click Save and EndNote creates a copy of the library.
The new library does not open, it is simply saved to disk, where you can then open it with
EndNote. EndNote leaves your original library open as it was before the command was chosen.
Note: The Save a Copy command also creates a [library name].DATA folder for the new library
and copies all necessary files and images to it.

Some ways to manage your references:

= There is no limit to the number of references, but it is recommended that you not exceed 100,000.
= Edit References: Double-click on the reference to open and edit.
= Add file attachments: Right-click on a reference in your reference list to attach a file/s. The
attachment icon will show before the author name. You may attach multiple pdfs, Word docs,
images to a reference, but only one audio or video file.
= Add a figure: With the reference open, right-click and choose “Figure” to add one graphic or
file into the Figure field of a record -- the figure can be cited in Word.
= Add keywords to your references to be able to search and find them later (especially if the
title is not descriptive). This can also help you to organize your library by topic.
= Sort References: Click on the header (Author, Year, etc) to sort all references by that category.
= Create Groups: Within EndNote you may wish to create groups to organize your references (under
“Groups” / “Create Group”)
= Move References: It’s easy to move references within groups (using copy/paste or “Groups”/ ”Add
References To”)
= Delete References: Highlight reference/s to be deleted, right-click and “Move References to Trash.”
=  Find and Delete Duplicates: Choose “References”/ “Find Duplicates” — duplicates will be highlighted.
With the duplicates highlighted, right-click and “Move References to Trash.”
= Use Edit / Preferences to customize your library options -- e.g., change to Unicode font if you’re
including references in other languages; “change case” for words that need to stay capitalized.

TIPS Itis necessary to double-check every reference, especially those exported from certain
databases. Look at:
= Page numbers. Many databases only export the first page of the article.
= Capitalization. In some cases, you'll need to manually change the entry from all caps.
= Corporate author names. When entering a corporate author, you should follow it with a
comma (eg, Smithsonian Museum, ) — otherwise EN treats it as an individual author. EN
assumes everything before a comma is a last name
= Title. Some databases add descriptive information to a title to indicate the topic.
= Journal. Some databases will include full citation information in the journal field.
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» EXPORT CITATIONS FROM LIBRARY CATALOGS AND FREE DATABASES
This option allows you to download citations from freely available library catalogs, including ODU, and from
PubMed, which is a freely available database from the National Library of Medicine.

1. From the “Tools” menu at top, select “Online Search” (or, use the Groups column at left).

Select a catalog, or PubMed, and then click “Choose.”

3. Perform your search using the fields and Boolean operators as needed. Click “Search.” (If using the
ODU Library Catalog, use "Any Field" rather than "Keywords.")

4. [Notice the number of citations retrieved. You may need to revise your search, or just select the first
10 to review.] Click OK at “Confirm Online Search.”

5. All citations will be added to your EndNote library.

6. To delete references not needed, highlight the references you don’t want, right click, and choose
“Move References to Trash.”

N

Note: It may be more efficient to search the PubMed database directly, and then export your citations to
EndNote. For books, you may wish to search the WorldCat database (millions of books) and then export
citations. See instructions below.

> EXPORT CITATIONS FROM LIBRARY DATABASES DIRECTLY INTO ENDNOTE
Each of our databases has its own way to present citation information. EndNote works with many of them
to allow a direct export from the database into your EndNote library.

EBSCOhost Databases (Academic Search Complete; America History & Life; CINAHL; Communication & Mass
Media Complete; Education Research Complete; ERIC; Historical Abstracts; PsycINFO; SportDiscus; etc)

1. Perform your search. From your results screen, select an item or mark items to export by clicking "Add
to folder" under the citation.

2. Click “Folder View" on the right (or at top) to view marked items.

3. Onthe Marked ltems list, click "Select All" (or choose specific items); =
then click the "Export" icon (with green arrow).

4. Select “Direct Export to EndNote...” (Itis a good idea to un-check “Remove these items...” in case you
need to get back to them.) Then, "Save."

5. Select and open your EndNote library. Citations should now be available in EndNote.

Engineering Village (Compendex; Inspec)

1. Perform your search. From your results screen, select an item or mark items to export.
2. Click “Download" at top; then choose "RIS, Endnote..."; then, "Download."

3. Inthe "File Download" box, click "Open."

4. Select and open your EndNote library. Citations should now be available in EndNote.

Google Scholar (scholar.google.com)
Be sure EndNote is set up in the “Bibliography Manager” in your “Scholar Preferences.”

1. Perform your search. Within your list of citations, click "Import into Endnote" for each individual
citation you wish to export.

2. Inthe "File Download" box, click "Open."

3. Select and open your EndNote library. Citations should now be available in EndNote.

Page 3 of 6 -- 3/28/2009



JSTOR
If you don't already have one, you will need to create a My JSTOR account.

1. Perform your search. From your results screen, select an item or mark items to save. Before moving to
the next page, be sure to click "Save Citations" at the top of the citation list.

2. Go to MyJSTOR -- "Saved Citations."

Select All items (or choose again); then, "Export Article Citations"; then, click "EndNote"; then, "Open."

4. Select and open your EndNote library. Citations should now be available in EndNote.

w

OVID (Biosis Previews; EBM Reviews; Philosopher’s Index; Zoological Record; etc)

1. Perform your search. From your results screen, select an item or mark items to export.

2. From the "Results Manager" on the left, under "Result Format," select "Direct Export." Then under
"Actions," select "Save."

3. Select and open your EndNote library. Citations should now be available in EndNote.

Project Muse

1. Perform your search. From your results screen, select an item or mark items to export. You will need
to "Save Marked Results" before moving to the next page.

2. Click "Email/Export Saved Results" at top.

On "Saved Results" page, select "EndNote" and click "Export."

4. Select and open your EndNote library. Citations should now be available in EndNote.

w

ProQuest (ABI/Inform; Dissertations/Theses FullText)

Perform your search. From your results screen, select an item or mark items to export.
View marked items from the "My Research" tab at top.

Select "Export citations..."; then, "Export directly to ProCite, EndNote..."; then click "Export.
Select and open your EndNote library. Citations should now be available in EndNote.

PwNPE

Science Direct

Perform your search. From your results screen, select an item or mark items to export.
Click the "Export Citations" icon.

Choose "RIS format..."; then "Export."

Select and open your EndNote library. Citations should now be available in EndNote.

PwnNPE

Web of Science (Arts & Humanities Citation Index; Science Citation Index; Social Sciences Citation Index)

1. Perform your search. From your results screen, select an item or mark items to export. Before moving
to the next page, you need to click "Add to Marked List." View marked items from the "Marked List"
option at top.

2. Choose “Save to Endnote, RefMan, ProCite.”

In the "File Download" box, click "Open."

4. Select and open your EndNote library. Citations should now be available in EndNote.

w
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» SOME DATABASES REQUIRING IMPORT VIA FILTER FILES
While some of our databases do not provide the direct export, EndNote provides filters to interpret the
citation information from the database. You may need to go to the EndNote download site for filters:
http://www.endnote.com/support/enfilters.asp

Cambridge Scientific Abstracts Databases (too many to list!)

Perform your search, mark records, and then select “Update Marked List.”

Select “Save, Print, Email” at the top of the records list.

Select: “Marked Records,” “Full format,” “Text” (doc format); “PC” (file format). Save.

In File Download box, “Save.” Save as a “Text Document.” Then, Close.

Open your Endnote library. From the File menu select Import, then open your text file.

At the Import Option dropdown list, select “Other filters”, then find the CSA filter for PAIS or ASFA.
Click “Import.”

ok wneE

FirstSearch (OCLC) (WorldCat, Arts & Humanities Search, GeoBase, etc)

Perform your search. Mark records to be exported.

Select “Marked Records" at the top of the page.

Click "Export"; then, Export to "EndNote"; then, "Export"

At the File Download box, select "Open" to save directly to your EndNote library.
From the Import dropdown list, select the OCLC filter for the database used. "Choose.'
Your citations will appear in your library.

ok wnpeE

Gale Databases (Literature Resource Center, MLA Int’l Bibliography)

Perform your search. Mark desired records to export.

Click on “Marked Items” at top. Marked items will display.

Click “Citation Tools” in “Tools” box.

From “Export to third party software” options, select “EndNote” and click “Export.”
In the “File Download” box, click “Open.”

Select your EndNote library. References should appear.

ounkwnE

Note: Gale databases do not export easily or well. You will probably need to go back to your citation list
to copy and then paste information (such as journal title) that did not export appropriately or at all. In
some cases, it may be necessary to copy the entire citation and paste it into a New Reference
template; then move the individual citation items to the appropriate fields.

PubMed

1. Perform your search. Mark desired references.

Select “MEDLINE” from the pull-down list next to “Display” box above citations.

3. Select “File” from the “Send to” drop-down menu. (If popup block appears, click the message line and
then select "Download File..." -- You may need to repeat Step 3.)

4. When prompted, “Save” the record/s as a text file. Then, "Close" the file download box.

5. In EndNote, select “File / Import”
e Import data file: select “Choose File” and select your text file, then “Open”
e Import Option: select “Other filters” and “PubMed(NLM)” filter, then “Choose”

6. Click “Import”

N
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SciFinder Scholar

Perform your search. Mark the records you wish to download (up to 100).
Go to “File / Save As” For type, use Tagged Format {*.txt}

Records are automatically saved as a text file (.txt). Exit SciFinder Scholar
In your EndNote library, select “File / Import”

e Import data file: select “Choose File” and select your text file

e Import Option: locate the appropriate filter ie SciFinder (CAS)

5. Click “Import.”

PwnNPE

WilsonWeb Databases (Art Full Text, Education Full Text, Essay & General Lit, Library Lit)

Perform your search and mark records to save.

Click “Exporting/Citing” from the top toolbar.

Click the marked records option (or all) and the “EndNote Filter” option; then “Export.”

Two boxes will open. Close the “File Open” box. In the “Wait” box, right-click on the “here” link and
save the file (in RIS format). Close the download box.

In your EndNote library, select “File” / “Import” and open your RIS file.

6. From the Import Option dropdown list, select the WilsonWeb filter; “Import.”

PwnNPE
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> DATABASES WITH NO EASY ENDNOTE EXPORT OPTIONS: Lexis/Nexis and Factiva

In some cases you may choose to copy the citation and paste it into a New Reference template;
then move the individual citation items to the appropriate fields.

ALWAYS PROOF YOUR CITATIONS CAREFULLY !!

he Groups column on the left is new to EndNote X2:

e All References - displays every reference in the library (even they are in other groups, etc).

(Note: Removing a reference from a custom group does not delete it from the library. It removes the
reference from the group subset, but the reference still exists in the library’s All References.

e Trash - a holding place for references you have removed from the library but have not yet permanently
discarded by emptying the Trash.

e Custom Groups - manually created by the user to help organize the library; you can drag-and-drop to copy
individual references into a custom group. (Maximum of 500 Custom Groups and Smart Groups are
allowed.)

e Smart Groups - use search criteria to dynamically update groups as existing references are edited or new
references are added to the library.

e Online Search groups - allow you to easily initiate a search of a favorite online database and quickly view
the latest download. (You may wish to switch to Local Library Mode for online searches.)

e EndNote Web groups - allow you to easily initiate a transfer of references between an EndNote Web
K folder and your EndNote desktop library. /

( N
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